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1. SAM-BAfEj />

SAM Boot Assistance (SAM-BA) # {42 fit— % ¥ itk T H ke 4 725 T-Microchip SAM Arm® Thumb® ] 5
Frbl. ixXebT BIEFil fH5h85%5 3% (Dynamic Linked Library, DLL) ——AT91Boot DLL, i%zha4#E%E
HSAM-BAMI T A ISP T HALFH .

SAM-BAH T1EPC Lz 4T EHLEITEH 7 FLE (SAM-BA GUD 581 R4k I H brssft (Cortex-M#%
) Z [a) g EE .

Fiv S P 3@ 5 B WL -
UsB
+  UART
- JTAG

&1-1. SAM-BAZE MR

SAM Device

System Board

-

1.1 /INEFF R

FERNE ENE R, 7E EHLTE RN A 2 A A PAT B/ G HEBR IR AR, HAR AR AT 2 ThRe. Bk,
JUK R N appleti) AR AT INE BIRAMA . “applet” #t/e Hx Bz 47 i — /sy, #tSAM-BAHI KA fiE
BT RVEFEAE S AR IRRWII A B AN B X T BASAMS T &, 5 M S H —
LBV -

1.2 SAM-BAS#E5%

B E5SAM-BA GUIHHTIEE, WZIAE HArastF FUE 4 N SAM-BA H  #51 an 2 TR B FE T . — L4 SAMES H-1E
H O E A SAM-BA AR 2 AL FIROMA (ILE1-2) , Lg% 45 SAM-BA ML 2%,  [K I 4 50K SAM-
BA ML ZSIN#E B AR NS (LE1-3) o Ja— MR 28 EIFR N EROMESA:
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&]1-2. #ROMISAM & Ziti

Host
v UART { = mamn
i Yy
! G o
9 MicrRocHIP p
( SAM Device Bl
USB | ( .
; T SAM-BA Monitor
1 |~ Y s i . 1
V + » Applets
1 [ : - . !
L U JEPUCN 4
| ,' Y ! ! . 3 R ¥ W
: PC i | SAMROM-based System Board

&1-3. N ROM¥ISAM R ZitRk

Haost
o = = 5 S | o \
! i |
H 1 1
! ] i
i i i
! i I
i 1 1
! i |
| i i
H 1 b 1
i i i
: I I = Appiala
| i |
! ] H
i
i i i-b- SaN-BA Moritor
3 f g J |
| = !
| 1 1
] i i
i PC ! SAM ROMesR-hasac Sysham Seard !
o = = - —— - -

SAM-BAW L2 NILAIRAE A LINAESRAL T —Fpfai s i 57k . SAM-BAME 1125 32 FrUSB-CDCHIUARTIEAE »
SAM-BA¥ #8246 MIUART F1/BRUSBHE 1 B B 464 o 240 ) 52 3h 2 £F,  SAM-BA W ¥ 28 £33k A\ TG PR 76
IR, 24%SAM-BA GUIH4 .

USB#: LR sl 26— T . 24 SAM-BA WL ML 284G I 21 =M LAZS 2 I, E¥ T 4 5 SAM-BAT 4
UARTHE: ORI h 4N “47 « HJSAM-BA M AR B Z /70, e BT 6% 5 SAM-BAM 4.

© 2018 Microchip Technology Inc. MAH%E DS00002565A_CN #5171



AN2565

2. TFEROM Cortex-M2&44:

TRIIE T ALK SAM-BA ML Z3 g FERIROM A (IR FATH ] HFfE, SAM-BAMMIALTINGFH) KA
Cortex-M#3 . Microchip % H XPlained Prot #Z{f: " SAM-BAIE AL #5751, ANisk SAM-BANE ML 25 14 =& — 2K
JRET B, A LRI B TEROMP i R4 AT 23 1E b

#£2-1. LROM Cortex®-MZE 4

SAM L22 SAML22 Xplained Pro (SAML22N18A) Cortex-M0+
SAM L21 SAML21 Xplained Pro (SAML21J18B) Cortex-M0+
SAM D21 SAMD21 Xplained Pro (SAMD21J18A) Cortex-M0+
SAM C21 SAMC21 Xplained Pro (SAMC21J18A) Cortex-M0+
SAM D5x/E5x SAMES54 Xplained Pro (SAMES54P20A) Cortex-M4
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3. WHEXR

SAM-BAIG ML #8E FHIE IO CHZFEF NS SRk 2 SAM-BAE L 35 5 238 2 AT N L P I AF -
TNRFIW TN OGS LU .

£ 3-1.SAM-BAE LZ UARTHE AUER

UART RXD AT S (115200-8-N-1) U2k %
UART TXD AT S (115200-8-N-1) K iELEiK
H24F2 P HEN S| TR e AT BRI, $04T R A2 P 5007 i SAM-

BAT ML 4) HIGPIOF| il

#3-2. SAM-BAM L2 USBIE R E

R

USB D+ 5EHMUSBZEE:
USB D- 5HEHHUSBZES:
S SEINCY MFHE AT DL (B, AT N2 B A0 i SAM-

BATHL#r4) HIGPIOS| i

: A RAERE B AT BUSBIE A (AR (] 85 145 08 ZOR IS, 15 2 WA R 8% 1 B0 808 7 0 A/ o i 242 3 o
v

oRr m:
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4. B

AN 210 B B 3 T Atmel Studioft) 75 SAM-BA G AL 28 N AR - R AL S B AIRARAS, FEal A4 A sk 2
AR HE FIAR/KEIL

4.1 TP 2R LS

T EONSAM-BA W A 3% 5 FHFE 7 A N A7 45 18] . 2% 13] LOx00000000 1|37 FH A2 2 4 kit (0x00002000)
AR Egm RS H 4 (B, GCC/IARFIUART, Fi/B{USB-CDC ) 2 [f]ft—Zitk.

B 4-1. BRAF ARl B ot

0x00000000 0x00000000

SAM-BA Monitor

reserved Memory Space il e boiEe

0x00002000 0x00002000

Application Application

Binary image with Binary image with both
Application code only SAM-BA Monitor and
application code

42  RIHEREH
PR 2 % S B A B v 7 S T
«  UARTHIUSBIREN LT 37 £ ILROM Cortex-M2 4 F 4 F ik 2 b ik
o EARMFIZEICH, ZE F Atmel Studio 7K SAM-BA Wi 1 £ 4 A2 EI g
o TR TR R AR B HT i A i Atmel Studio 7RISAM-BA GUI 2.xx
«  [FHARM/GNUZw##56.2. 181791, JFiE47i4k -Og, STACK_SIZE=0x280, --specs=nano.specs

43 RE
SAM-BA I HI #5 F F2 Fp SRR FH P 7 SR EAT E fI I RC B . DA 2 7 i) (R AH B -
«  UARTAHI/BUSBIE(E #2111
- {EfEHUARTHS, #4F FASERCOMALH
o FEHISAM-BA RS BT ¥ 28 F2 5 1EN 51 1
o SRR RCAAHLNE, BN R T s ik 7R
- NSAM-BAFHLH B A MR

© 2018 Microchip Technology Inc. MAH%E DS00002565A_CN #8171



AN2565

— 8RR R R A AG Hh b
NRHNH T -5 N AT A A E
Ra-1. =B HEFHHISAM-BARE B

SAM L22 (SAML22N18A) WlER USBFIUART
SERCOM3L SERCOM4 (PC24DHIPC25D)
HZEREFHEA G| PCO1

SAM L21 (SAML21J18B) iR AN USBFIUART
SERCOM3 4l SERCOM3 (PA22C#IPA23C)
SR S PNG1Y PA02

SAM D21 (SAMD21J18A) WlER USBFIUART
SERCOM3 4l SERCOM3 (PA22CHIPA23C)
SR S PNG1Y PA15

SAM C21 (SAMC21J18A) WlEr USBFIUART
SERCOM3L SERCOM4 (PB10D#IPB11D)
SRS 3 PG PA28

SAM E54 (SAME54P20A) s USBFIUART
SERCOM3 4 SERCOM2 (PB25DHIPB24D)

SR eSS INC]Y:|

PB31

4.4 FhERERBER

SAM-BA WAL #% B2 FH AR 7 1) B Ar A A BRI A2 FTSRAM, - R 1k mI DK HL 2 4 31 32K I A7 AT4K SRAMEE /)N
JOFEE . NRUH 1A F 1 N A AT SRAMAE AT L -

v BHTRA I Atmel Studio, ARM/GNU%Z%456.2.1, #4711k -Og, STACK_SIZE=0x280,
--SPEeCcs=nano.specs.

R4-2. SAM-BAE LR g2 B AL

B USB + UART (JAFF/SRAM) |{XUSB (JNF/ISRAM) |{XUART (JA7F/SRAM)
(AT A AL QUES LX) QUES LX)

SAML22N18A 4488/1168 3384/1160 2400/688
SAML21J18B 4508/1168 3404/1160 2420/688
SAMD21J18A 4524/1168 3436/1160 2464/688
SAMES54P20A 4768/1168 3716/1160 2952/688

HE: %A IO IS OLE BT RERETT AR BRI AR AL (R, T RAER AL S ) TAEAL .
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5. B4 PESAM-BA LT 22

AN H LR L SAM-BA Y 41 28 1 VEACHY, H 45 4F % GCCREE B i Atmel StudioZi H . K SAM-BA W 41
BT A SRS, A B e SAM-BAL MBI H , i H B A& TRk .

DL P BREE X SAM L2237 B H 4 it . AT A At JTEROM Cortex-M #1435 nl 8 /G AR L) A0 3%

5.1 i Fl Atmel Studio3SAM-BA AL 22 HE FISAM L2274

FIFHFA N H 2B i $E A i zip e 48 S A4 H ) samba_monitor. atsin .

2. flE—"Ydevice_config LAt Je LA #54 HC B A AR L 28R R 8 L B SR . AR
device_config_saml22n18a.h. #3152 X5eia, WubHic & - &7
device_config\device config.h .

21, SAML22FAEHI LA N HCE -

2.1.1. {5 N ——USBHIUART, ¥ SAM BA INTERFACEEN
SAM BA BOTH INTERFACES

2.1.2. BRIl yaPP START ADDRESS (E[10x00002000)

2.1.3. ¥ B DL N ARG R B AR, B SAML22N18A S ##7 in | device _config.h:
#elif defined (__ SAML22N18A )

#include "device config saml22nl8a.h"
#define SAM BA INTERFACE SAM BA BOTH INTERFACES
#define APP START ADDRESS DEFAULT APP START ADDRESS

22.  futidevice_config_sami22n18a.h ' {fI T HAbZZ AR N B %, B LR IL S 2l 31 1 B ILAC .
ARMEVEAE R, 163 W ARSI EEE FH
e AN R IR AL S ¥ 5 f device_config.hRlldevice _config_saml22n18a.h (1.
3. itk Project > Properties (JiH > J&1:) T FProperties (JE1t) #4r, RJa SHiH:
3.1. Device > Change Device (#:f} > HEastt)
3.1.1. %k FNew Device CHr#ft) . A 2444t 5 ¥ Device Startup L1435 .
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Build

Build Events
Toolchain
Tool
Components

Advanced

Current Device: ATSAML21J188

Device Name: ATSAML21J12B
App./Boot Memory (Kbytes): 264

Data Memory (bytes): 40060
EEPROM (bytes): N/A
Speed: N/A
Ve N/A
Family: SAML2L

Supported Tools
» AtmelICE

X EDBG
X EDEG MSD
&, JTAGICE3

1 MEDBG
A Power Debugger
& J-Link

& J-Link over IP

& J-Link ARM-Pro
& J-Link Ultra

# SAMICE

Change Device...

Device Selection

Device Family: SAML22 v Show devices: | All Parts v Search for device

|nme App./Bact Memory (Kbytes) Data Memary (bytes)EEPROM (bytes)

Device Infos 4]
|aTsamizza164 65 8192 N/A Device Name: ATSAML22N13A
aTsamizzG17a 132 16384 N/A Scotk N/A
ATsami22G18a 264 32768 /A
|aTsami2z116a 66 8192 N/ i N
| t :
| Family: SAML22
[aTsamLzzI7A 132 16384 N/A i
[aTsamizz2inen 264 32768 nA Datashest (Summary)
|aTsamzanien 66 8192 /A Device Page g
[aTsamizan1TA 132 16384 N/A
ATSAMLZINIBA 264 32768 N/A S T

> AlmeHICE

X EDBG

X EDBG MSD

B JTAGICE3 -

il mEDBG

A Power Debugger
& JLink

O T

4. HURORIETUH o 6 SO e b ANk R SRR TR

5.2

5 B FH AR P 3T 1 TR0 A S g ik

1. TN R E, {6 H & #H1E samba_monitor 41 fic & il . A5 50x00002000.

1.1.

3L 1% $ Project > Propertiest] JPropertiesifi 73, 94 )5 S %] Toolchain > ARM/GNU Linker >

Miscellaneous ( T E4% > ARM/GNU%E:E > Hifth) .

1.1.1.

Build

Build Events

Device

Tool

Components

Advanced

WM-W1l, --section-start=.text=0x2000, o

Configuration: | Active (Debug)

=] Platform: [Active (ARM) -

Configuration Manager...

4 [#] ARM/GNU Common
& General
[ Output Files
4 [Z] ARM/GNU C Compiler
& General
[ Preprocessor
& Symbols
£ Directories
E& Optimization
£ Debugging
£ Warnings
& Miscellaneous
4[] ARM/GNU Linker
& General
o Libraries
E& Optimization
& Memory Settings
& Miscellaneous
4 [#] ARM/GNU Assembler
& General
£ Debugging

& General
& Svmboals

4[] ARM/GNU Preprocessing Assembl:

ARM/GNU Linker = Miscellaneous

W —-section-start=.text=0x20003WI —entry=Reset_Handler -W| —cref -mthumb -T./src/ASF/sam0/utils/linker_s

Other options (-Xlinker [option]}

Linker Flags:

Other objects

2. AT FIUSARTSRUSBE: (ORI RS, 7T A7 SRR SR TR B ATADAA ML . SLARARUE T R
T 25 5 0 T SAM-BA B B R B .

3. HF4mEUiH. Debug/Release (/KA ) LA I rb iy B F R 5 1 75 3 il AT a3k ) SC A B i Bf

e
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5.3

ASAM-BAENEHF AL/ NMEF

S FH LT D SR BT S AR P iR aa ik . A5G W]y SAM-BA I HLE 1l A0 2587 AF il /MR P I e B4l YT, 162
Jhttp://www.microchip.com//wwwAppNotes/AppNotes.aspx?appnote=en591431.

1. #%3SAM-BAZ A H 3, 1% HFEIME I N AL T Program files (x86)/Atmel/sam-ba.
2. ik Flapplets\samdat\sam-ba_applets\flash\ flash_app_main.c 1} .

2.1

2.2.

2.3.
24.

2.5.

U1 C AT IMONI TOR ST ZEZ: PAULHD € | SAM-BAW A &5 H (1) S R Fr it dh bk, SR /5
TRAESCAE
DU UL 4T FFCMDE [

2.2.1. 1t search programs and files (2 ZRFEFFRICM) #, Hilemd.,
2.2.2. U B B3 A PR A FH Ctrl+ Shift+Enter i 4EEnterdT 7F .

1% F cdfir 4 S 8l applets\samda1\sam-ba_applets\flash>( 3% .

TEMSCAR I, fi Amake —vin & UL Rnmakefi A& . R K ER, 5SS WM HZILHFIGNU
Make 3.81, AI7ELL T MHE T4k
http://www.microchip.com//wwwAppNotes/AppNotes.aspx?appnote=en591431.

Programs (1)

B cmd.oxe Ctrl+Shift+Enter
Documents (403)
1 User Account Control @
BulkOnly_scsi_cmdl.usb3g
uasp_scsi_cmdl.usb3g Do you want to allow the following program to make
uasp_scsi_crad2.usbig changes to this computer?
| sercom.h
nvmctrl.h |  Program name:  UserAccountControlSettings
ey . \‘! Verified publisher: Microsoft Windows
| gs_linh
. dmach
tech ) Show details [ ves
| compiler.h
usarth Change when these notifications appear
Files (562)
B CMD Screenshot.png Select Yes

B CMD Screenshot.png

| host_blsh_cmd.h

€] host_blsh_cmd.c

€ structblfwk_1_lcmd_t.html

@ group__shloader_structboot__cmd__t.js

Q structconfig_i2c__cmd__packet_t_ coll_graph.svg
|| structcenfig_i2c_cmd_packet_t_ coll_graph.md3
| structconfig_i2c_cmd_packet_t_coll_graph.map

4~ See more results

‘(mdl X | Shut down | » |

BN Administrator: C\Windows'\systern32\cmd.exe EI@

Microsoft Windows [Uersion 6.1.76811 -
Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:sWindowsssystem32>cd C:wProgram Files (xB6>“Atmel-sam-ha_2.17_rc4~applets samdalssam—ba_appletsf]] =
lash

C:“Program Files (x86>-“Atmelxsam—ba_2.17_rc4~appletsssamdal~sam—ba_applets~flash>make —v
GNU Make 3.81

Copyright (C> 2886 Free Software Foundation, Inc.

Thiz iz free software; see the source for copying conditions.

There is N0 warranty; not even for MERCHANTABILITY o» FITNESE FOR A

[PARTICULAR PURPOSE.

This program built for i386-pc—mingw32

I FemddE 1, iziTmake.
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B Administrator: C:\Windows\system32\cmd.exe EI@

] \Ploglam i (x86)\ﬂtmel\“am ha_2.17_rcdhapple samdalssam—ba_appletsflash>make
- : In function ’‘nvm_get_fuses’:

948:2: warning: dereferencing type—punned pointer will hreak
ict—aliasing]l

B ((u1nt16 t*)&lau _fusehits>[@]1 = (u1nt16 _tYNUM_MEMORY [NUMCTRL_USER ~ 21;

larm—none—eabi—objcopy —0 hinary binsapplet—flash—samdaljlba.elf binsapplet—flash—samdalji6a.bin
larm—none—eabi ze obj/sram_interrupt_sam_nvic.o obj/sram_nvm.o obj/sram_system.o objssram_flash_app|
| main.o ohjssram_applet_cstartup.o binsapplet—flash—samdaljl6a.elf
text data hss d k filename
92 5 oh,]/.,lam interrupt_sam_nvic.o
1648 Pam_nvm.o
46 8 ] m_system.o
848 44 ] m_flash_app_main.o
188 j/sram_applet
2484 68
arm—none—eabi—obhjdump —h -8 hinsapplet—flash—-samdaljiba.e
*[* iz not recognized as an internal or external command.
opexahle pnglalTl 01 hatch file.
cubdipre

26.  HEHEM ﬁﬁﬁm#r“fbmxﬁ:%ﬂiﬂétﬁk
2.6.1. H:3tcl-lib\saml22_xplained_proCitJ¢, 5 itk ot
2.6.2. HJHSAM-BA AL HIRE R, A FH S8 5 i — skl SCf
RSB R ISE T, SAM-BA AL 35 FISAM-BA NN ] BE I AESAM L2228 F£ H
i ToROM Cortex-M#3 £ 30 e s 542 44 1 537 J5 (0 /NRE AR S . b1 SO Rintel S04
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6. {5 FISAM-BA L #1.2%

6.1  4TESAM-BAISHLE

Al H AT AR (Serial Wire Debug, SWD) #:3L % FESAM-BA I 1 25 :

7£Atmel Studio™i%#% Tools > Device Programming ( T.E > 2$0F4ifE)

% Tool (LR , 55 EApply (R .

MMemories (f7fik#%) Ik, #id;Erase now (SZRIIEER) , B5bh Fr#ERR.
fEFlash (NA7) FBh s 2 SAM-BAI AL 3s AL (%42, SR )5 HidiProgram (ZRfE)
& 6-1. Bz

P 0bd =

v | Advanced

User Page (256 bytes)

~ | Advanced

Reading target voltage...OK

(] ox

[¥] Erase User Page before programming
Read...
I Werify User Page after programming £a |

EDBG (ATML2547020200000049) - Davice Programming ? P
Tool Device Interface Device signature Target Voltage
EDBG v | ATSAML2ZNIBA =~ [SWD | |Apply| 010820000 Read| 33V |Read| [§|
Interface settings Device
Toel information [Erase Chip 'l [ Erase now ]
Device information Flash (264 KE)
Memaries Ch\Atmel Studic\SAMBA_BOCTLOADERINSAMEA_BCCTLCADERI\Debug\SAMEBA_BOOTLCADERLhex ™ | w
T [¥] Erase Flash before programming :
[¥] Verify Flash after programming frogram | [ Menfy I [ Resd I
Security

=

W Close U

5. mi#, A LME ] 64T 4 e T BatorogramZi e+ o5 BEHISCE . BLUR R B1E] T 4% 7 SAM L22 Xplained

R HISAML22N18ASE {1,

atprogram -t edbg -1 swd -d atsaml22nl8a program - f
samd21l sam ba both interfaces.hex

6.2  FHASAM-BAKHLE
A LI AR AR 4% P R0 SAM-BA FI 262
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SNBSS N BLAR AR, # B 2R HEN G IR o 38 K VR A mT e FH P 5 0 A
NSAM-BAIS ML EHid A & . FH P s ZRAE 2 AF v B A % A 12

RS EHEIR B 0F S BRI AEF E AL & (@APP_START_ADDRESS +4) M=%} (OxFFFFFFFF) .
El6-2. SAM-BAMHLE: 5| Sid 2

Is the Bootloader
Entry Pin LOW?

YES

NO

Is App Reset vector

OxFFFFFFFF? YES—>»| Execute SAM-BA Monitor Setup

—_—
NO
4 ls USB enum Run SAM-BA in
Success? YES—> " sB Mode
Jump to
Application
S
NO
Is # received Run SAM-BA in
NO on UART? YES™> " UART Mode
—
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7. ZEWindows® iZ41T7SAM-BA

K ERAHFEWindows PC_LIZ{TSAM-BA GUIRIIEA LR, A K581, 152 NLSAM-BAH] 45/
(<samba-install-directory>\doc\sam-ba user guide.pdf) .

7.1 %H:SAM-BA GUI
T UART 32 1148 F SAM-BA W IS, 7% 3 i K 00 1] ) COM 11 Bl 532 0 B 4735 FLHS R 24 6 3 3 PC
W: XTFSAM L22 Xplained Pro, UARTH: {# FHDEBUG USB i i /7% H -

Select the connection : iCGMlEQ' Lurﬂﬂ

Select your board : isamIZE_prained_prD[nc:t fa
JLink TimeoutMultiplier : Iﬂ ﬂ . C SWD

ﬂ & JTAG

[T Customize lowlevel

Connect i

FHE T USBE f# HSAM-BAW #1 28, 751l TARGET USBiii I 4% B2 FPC.

™ SAM-BA 216

Select the connection : [\USBserial\ COMLT0 T L e

Select your board : [ElglPeS sl E = M= l= 4] ™ @ ITAG

JLinkTimeoutMuItiplier:;U ﬂ = SWD

[T Customize lowlevel

Connect I Exit

HidiConnect (&) , SadFErER.

7.2 RERE

WRIERL RIS, R B8 LU SAM-BABE RS, 2B R SR S A P EAT S MAZ . BRI, P H
BERDA M HIRER, SR)5 e b ok, A Flashik iR NI N & . R B RN, #4E
Hu k255 SAM-BA I LS /N Fr b O BC B AEAHILEC (ZESAM-BAIE L& 7- 6t Jy0x20000 5 B0, &k
AR L.

Wtz
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1. ﬁ?%Erase appllcat/on area (RN H ﬁ?l:iﬁ) Efﬂzlif%‘fiﬁ"r ﬁﬁﬁfh

File  ScriptFile Help

saml22_xplained_pro Memory Display

Download / Upload File
Send File Name :
Receive File Name :

Address : 0x00000

Scripts

Start Address : [0x20000000 ey Display format Applet traces on DBGU
Size in byte(s): 0100 © ascii € 8-bit C 16-bit & 32-bit infos || Apply
0x20000000 0x00000135 0x00000109 0x00000371 0x0000011D 2
0x20000010 0x00000000 0x00000535 0x00000349 0x00000119 i
0x20000020 0x0000011D 0x00000339 0x20000080 0Ox2000003¢
0x20000030 0x20000094 0x2000003C 0x200000A0 0x00430209
| [OUSOSRCAD__0uSAGANIND  NGROAGDEN  AwNSNONIAG _AmdASORND .
Flash

Size (For Receive File) : 0x1000

= Send File
E”'I Receive File

Compare sent file with memory

byte(s)

[ |Erase application area

j Execute ]

SAN-BGA CONSUIE Uispidy acuve (105.9.9 / 1K8.9.9)
(sam-ba_2.16) 1 %

(sam-ba_2.16) 1 % FLASH::EraseApp

Start row: 0x00000060

End row: 0x00000100

Application area erased

(sam-ba_2.16) 1 %

2. EFRER BN O,

-
E SAM-BA 2.16 - saml22_xplained_pro[not factory programmed] I

\USBseria\COM170| Board : sami22_xplained_pro[not factory programmed]

SRIG K Address (Hbdik) T E550x02000.

ESREal ™)

f File  ScriptFile Help

saml22_xplained_pro Memory Display

Start Address : 0x20000000 Refresh

Size in byte(s) : (0100 © ascii
0x20000000 0x00000135 0x00000109
0x20000010 0x00000000 0x00000535
0x20000020 0x0000011D 0x00000339
0x20000030 0x20000094  0x2000003C
0x20000040 0xC0000102 0x00040932

.

Flash

Download / Upload File

Display format

" 8-bit " 16-bit & 32-bit

0x00000371 0x0000011D
0x00000349 0x00000119
0x20000080 0x20000034
0x200000A0 0x00430209
0x02020100 0x24050001

m

Applet traces on DBGU

Einfas ~| Apply

m

[ Send File Name :|C:/Atmel Studio/GETTING-STARTE

D1/GETTING-STARTED] ﬁ" Send File

Receive File Name :

Address : (0x6D00

Size (For Receive Fil

Scripts

E"'] Receive File

€) : 0x1000 bytel(s)

Compare sent file with memory

Erase application area

j Execute

T UATUG GYIES WiTWEn Uy GPpet
-I- Writing: 0x100 bytes at 0x8800 (buffer addr :
E3 0x100 bytes written by applet

.-I- Writing: 0x100 bytes at 0x8900 (buffer addr :
- 0x100 bytes written by applet
-I- Writing: 0x84 bytes at 0x8A00 (buffer addr :

. -I- 0x84 bytes written by applet

(Desktop) 1 %

0x2000297C)
0x2000297C)

0x2000297C)

\USBseria\COM170 | Board : saml22_xplained_pro[not factory programmed] -

3. #iiSend File (Ki% )

7.3 JI A
SAM-BAEHLF AL LA R File A,

SR IG HitiExecute (H47)
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RT-1. BisE WA

B

H1zafr

[E4: 7 XA
PR B AR e X 35K

GO EE ST
B £

TEIE e IS 22
FEEEEID
152 B A 72 £2[0:15]

Braffn gt st e s, GREMAER, 53N
EARBHEEEFM PR “NVMCTRL” —#.

RS AT A 2 ARES

BERPTA MR P ARS (A 2% B SAM-BA i #1L 4%
XD .

BEER I RE P I3 — TT

REELBEE. ARENER, HSLEARS
PEEEE T B “NVMA] P AT #6873

PRSI ra-t
PR IR A AP A

BEE AR E BUE LT BT LB INAF X 3. 47 R VE4H
FHE, HSLEASEEEE T MK “NVMCTRL”

— 2,
FREE 4 0 TN A X 8
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8.  HABRITR

SAM-BAI AL A B TR At 1 2 A AL T, R AN 1 ASE L U 4

%8-1.

SAV-BALLHL B

FETASFHISAM-BA G 1 #%

FETROM[ISAM-BA I 125

&4 ARTI H

SAM-BA s ¥ 28 F Atmel & {HHE 42 (Atmel Software
Framework, ASF) #HiT7H &, BT E A5 NI
| ) & F SERCOM i USB 52 51| B 48 4 # 42 5K 5 &
J7, RIS AT As oAl 2 25 Fh 2814

HTASFRIR R, HRSFHA—, CRHAASF 3.32
i~24 KB) .

TE A ROMM — 235 4F (5] i Cortex-M3/M4/M7 %
BISAMZEE) 1, SAM-BA¥I#EFIROMA ., ¥
HF ALK FIGPNVMAL 15 B T 0E . B R EE
B, B I ARISR IS T M.

A 2L B Zip SO B G LR AR I -

*  Atmel-42238-UART-based-SAM-BA-
Bootloader-for-SAM-D20_AP-
Note_AT04189.zip

*  Atmel-42366-SAM-BA-Bootloader-for-SAM-
D21_ApplicationNote_AT07175.zip

© 2018 Microchip Technology Inc.
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9. TR

*  Atmel-42438-SAM-BA-Overview-and-Customization-Process_ApplicationNote  AT09423.pdf

*  Atmel-42728-Using-SAM-BA-for-Linux-on-SMART-ARM-based-
Microcontrollers_ApplicationNotes  AT15004.pdf

+  SAM-BAHIJ/'#5F: <samba_install_dir>\doc\sam-ba user guide.pdf
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10. FR&EPS

#10-1. [REA—11/2017

AT HIRIIR AR o
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fEE . FEAE & A ELBC P SE 25 RO el U7 1), st B it DL RS 2.

o PERXF——HEFMARE. NHECHRGIFET . B SEIR. H SRR DA SRR . &
BT ER A WA LS VAR A

o —REARZIF——FIIE (FAQ)  BIARSCFRER. 7EL TR 2 DL Microchipii il t1K1l 5 71 4 H

+  Microchip)rgs——r= Sk R AT e 7 . feHTMicrochipr i fa . BF 2 A% 3 % HEZ . Microchip
B BRI AL T REFIE

AR IB A RSy

Microchip #1785 52 3@ %1% i 55 B T 7 1 filfMicrochipr= i (1 R (5 8o 1A 7 o] 7E A AT IRk ¥ Ha A
PRI BOT R THRAEASH L S AT HT A B iR RN, i3 H e SRS A

BRIFEME, 3% 5t Microchip M st http://www.microchip.com/. 7E “3Z#F” (Support) T, i “AFHilAN%
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B

Microchipy= i i) FH 7 alad ik LT B3 $R15 45 B
o REEFIMAE
o CUHEE R
R TR (FAED
o BORSH
TR R AREE R . ARRESH TR (FAE) F3RSCRE. U & F o & et 8. &3¢
VLR (i) = v
W] LR WS sk A3 5 R SZRF: http://www.microchip.com/support

MicrochipZs RS4RI ThBE

THER LT A KMicrochip s A AURS DR 37 T BE 2 ki -

«  Microchipft)7= i 341 2l Microchip 2 Tt Bk (R R 4547

«  Microchip#fifs: TEIE® 1R KIEH T, Microchip 27177 42 24 4 1 7 b 8 2577 5 vb d 22 4 1 77
Z
Hal, A EEGR. HE RIS R REMAT . BRERATTRD, T X S AT A EAS & DA
Microchip % T b 1 & i #4E H 36 kA8 F Microchip™ i () . X RER A AR AT BE12 90 T SR A

+  Microchipg & 5 UL 52 B 1% P A1 .
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XFAT A F B AAERERBTE LT, e U7 10 18 B B AR 52 FRBLORY IR, 8 BRI 1205 4
EYFs, A BT

TR

AR A i 0 2 N S SR A SRAL A R DO IR SR, EATR Rt R 2 A5 BT B A B IR
MFFEHARRE, REE SN THE. MicrochipXf X 2efE B AR MR B 2 P ei Ak, & 8
Foft B R A B s di R, AR TR AT IS O, U PRAE. & A P B 2 I 1 ol A 1 7
IRV

Microchip PRIIX 2445 2 B fif I e 45 B 1M 51 ) Ja SRAVRSEAE M 534 . a0 Rk Microchipas {4 H A= a4 7
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